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ED I TO RI AL

This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

W

elcome to the first Full Circle of 201 6! We're back to a full house with Python,
LibreOffice, Inkscape, LaTeX (for valentines day, of course) and the start of a new
series on migrating from VAX/VMS. It's a bit over my head, but it's still an interesting read.
Also very interesting is Tom's quick HowTo on using GnuCash for your Internet banking.
Elsewhere, I continue with my Arduino Brewduino (as I'm calling it) and the building of my
3D printer. I've also done a quick review of the new Vivaldi browser. Currently in beta2 state,
but still quite impressive. Speaking of reviews; Charles reviews his new toy, the MyGica
ATV582 TV box. I have a similar box (mine is DroidBox branded) and they really are nice.
In the world of Ubuntu phones we have OTA-9! This is a big one as it's a major update to
the Unity that's been running on previous Ubuntu Touch versions. We're getting ever closer
to the convergence! Whispers on the grapevine tell me that a convergence device will be
unveiled soon. Probably as soon as next month.
You'll see it mentioned throughout this issue, but I'm experimenting with a new Full
Circle podcast of sorts. I was hunting for a Linux/Ubuntu podcast that did just news. No chitchat. Just news. And found nothing. So I'm thinking of starting the Full Circle Weekly News
podcast. Just news, and only about 1 0 minutes per show. I've released episode #00 as a
test/beta which has been refined in episode #01 . Is it something you'd listen to?

All the best, and keep in touch!
Ronnie

Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
http://issuu.com/fullcircle
magazine
https://play.google.com
/store/books/author?id=
Ronnie+Tucker
http://www.magzter.com/
publishers/Full-Circle

ronnie@fullcirclemagazine.org
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Submitted by Arnfried Walbrecht

THE FULL CIRCLE
WEEKLY N EWS

RASPBERRY PI FLAVOUR
LETS ANYONE B UILD AN
U BUNTU OS FOR ARM
D EVICES

uses the MATE desktop interface in showing convergence on the
place of Canonical's Unity.
Ubuntu platform.There are two
desktop releases of Ubuntu
The tool grew out of efforts to planned for 201 6 - Ubuntu 1 6.04
build an Ubuntu MATE release that LTS (Long Term Support) and
supported Raspberry Pi, according Ubuntu 1 6.1 0. With LTS releases,
to the programmers.
Canonical likes to keep the releases
unning Ubuntu Linux on
stable enough for deployment in
Raspberry Pi hardware -- and,
Source:
an enterprise environment.
maybe, ARM-based devices in
http://thevarguy.com/open-sourcegeneral -- has become easier
Unity 8 - the desktop
thanks to a new tool called Ubuntu application-softwarecompanies/raspberry-pi-flavourenvironment that will allow for
Pi Flavour, which is developed by
lets-anyone-build-ubuntu-os-armconvergence - has not been used as
the team behind Ubuntu MATE.
devi
the default desktop environment
on any prior Ubuntu for desktop
The goal of the new tool is to
releases. Therefore, it may not be
"make as many Ubuntu flavours for
stable enough to be used as the
the Raspberry Pi 2 as we can,"
U BUNTU AIMS FOR TRUE
default in the LTS release, but it
according to its developers. That
CONVERGENCE ACROSS
will definitely be an option for
means releasing new Ubuntumore advanced users to select on
based GNU/Linux distributions that DEVICES IN 201 6
the login screen.
run on top of Raspberry Pi -- the
t seems Canonical, Ubuntu's
tiny, inexpensive devices that lend
parent company, may achieve its Source:
themselves to IoT-type
convergence goal in the new year. http://www.neowin.net/news/ubu
applications, among other
The move will allow you to get the ntu-aims-for-true-convergenceendeavors.
across-devices-in-201 6
same experience of Ubuntu
whether on PC, tablet or phone.
Ubuntu Pi Flavour is not a
This will likely mean apps, too, will
project sponsored by Canonical,
become cross-platform.
the company that supports
G OOGLE PLOTS WHATSAPP
Ubuntu. It's instead the work of
RIVAL WITH ARTIFICIAL
The news came from Ubuntu's
the developers behind Ubuntu
INTELLIGENCE
MATE, a derivative of Ubuntu that Google+ page. It posted an image
full circle magazine #1 05
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R
A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

I

NEWS

T

he service will pull information
from the web in order to
answer users' questions in addition
to allowing people to connect with
friends like a traditional messaging
app. However, according to a
report from The Wall Street
Journal, Google could be planning
a new way of going about getting
information. Google's own chatbot
service is headed up by Google oldtimer Nick Fox, who is now VP of
communication services at Google,
with sources claiming the search
giant has been working on the
service for at least a year already.
There are a number of popular
messaging applications like
WhatsApp and Messenger services
offered by Facebook, and WeChat
service offered by Tencent
Holdings Ltd. Google also has a
messaging service known as
Hangouts. The latest rumors say
that Google is working on an
entirely new messaging service,
but instead of just providing
messaging capabilities, it will also
feature chatbots. Google hasn't
commented about the WSJ reports
yet. Google may have a new
artificial intelligence project in the
works. Additionally, Google will
allow other developers to hook in
their own services via chatbots.

Source:
http://thevillagessuntimes.com/20
1 5/1 2/27/google-plots-whatsapprival-with-artificial-intelligence/

D EBIAN LINUX FOUNDER I AN
M URDOCK DEAD AT 42

KALI LINUX N ETH UNTER 3.0
CANONICAL: O NE B ILLION
ANDROID M OBILE
PEOPLE "B ENEFIT FROM "
PENETRATION TESTING
U BUNTU LINUX
PLATFORM RELEASED

S

ecurity researchers, ethical
hackers and pentesters can
ebian GNU/Linux founder Ian now rejoice. The ultimate
Murdock has died. He was 42. pentesting tool for Android
smartphones and tablets, Kali
Murdock, who lived in San
Linux NetHunter 3.0 Android
Francisco, is best known for
creating the open-source distro in application, has been released by
Offensive Security, the company
1 993. He had just last month
behind Kali Linux. The application
started working for tech startup
was in development for over a
Docker in the city. On Monday
year. Kali NetHunter 3.0 boasts of a
afternoon, he posted a string of
completely redesigned user
distressing and erratic tweets,
interface which has been
revealing he had been arrested
near his home by police, accused of application centric. Offensive
assaulting an officer, and taken to Security said that the new
hospital. He also threatened to kill application will support new and
himself. After people reached out complex attacks while providing
to him, Murdock appeared to calm support for managing your Kali
down, and vowed instead to clear chroot independently, including
the ability to delete and rebuild
his name. Murdock died that
the chroot, along with support for
evening. His Twitter account has
selecting individual metapackages
since been disabled.
in the respective chroot.
Source:
http://www.theregister.co.uk/201 5 Source:
/1 2/30/ian_murdock_debian_found http://www.techworm.net/201 6/0
1 /kali-linux-nethunter-3-0-androider
mobile-penetration-testingplatform-released.html
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buntu Linux has more than
one billion users -- or at least
people who "benefit" from it,
whether they know it or not -according to a recent statement
from a Canonical executive about
how many people actually run its
open source operating system.
Dustin Kirkland, who works on
Ubuntu Product and Strategy for
Canonical, said in a blog post that
"more people use Ubuntu than
anyone actually knows." That
language seems to be an admission
that Canonical actually has
relatively little idea how many
people run Ubuntu, and Kirkland
offered few hard statistics.
He did, however, provide some
figures that give a sense of just
how widely used Ubuntu is. The
most concrete ones center on the
cloud, where 20 million instances
of Ubuntu were launched in 201 5,
according to Kirkland. He also
remarked that Docker users have
created Ubuntu images more than
contents ^

NEWS

35 million times.
Noting that Ubuntu is also in
use on smartphones, Google's selfdriving cars, the servers of lots of
companies and plenty of other
places, Kirkland concluded, "I bet
there are over a billion people
today using Ubuntu -- both directly
and indirectly. Without a doubt,
there are over a billion people on
the planet benefiting from the
services, security, and availability
of Ubuntu today."
Source:
http://thevarguy.com/opensource-application-softwarecompanies/canonical-one-billionpeople-benefit-ubuntu-linux

LINUX KERNEL 4.4 LTS I S
U NOFFICIALLY AVAILABLE
FOR U BUNTU, D EBIAN , AND
LINUX M INT

long-term supported branch of the
Linux kernel.
Arne Exton is known to
immediately build a custom kernel
for Ubuntu, Debian and Linux Mint
systems based on the latest stable
and most advanced Linux kernel
release, version 4.4 in this case,
which users can install right now
on their supported GNU/Linux
operating systems (see below for
installation instructions).
But first, a few technical details
that you need to know before
attempting to install this custom
Linux kernel package on your OS.
The kernel 4.4.0-0-exton package
that has been compiled by Arne
Exton is the equivalent of the
Linux kernel 4.4 found on the
kernel.org website, it is supported
only on 64-bit systems, and has
been compiled the same way as all
official Ubuntu kernels are.

"I have compiled yet another
Ubuntu/Debian kernel for 64-bit
s you may or may not know,
systems. This time kernel 4.4.0-0Linux kernel 4.4 LTS was
exton, equivalent to Kernel.org’s
officially released on January 1 0,
latest stable kernel 4.4.0 released
201 6, and Softpedia was the first
1 601 1 0," said Arne Exton for
to announce it, along with the
details about the multitude of new Softpedia. "My self-compiled
features that were included in this Ubuntu kernels can be used in all
types of modern Ubuntu systems,
full circle magazine #1 05
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including Mint."
Source:
http://news.softpedia.com/news/li
nux-kernel-4-4-lts-is-unofficiallyavailable-for-ubuntu-debian-andlinux-mint-498837.shtml

GNOME SOFTWARE N OW
AVAILABLE IN U BUNTU
1 6.04, WITH A PPA

The Ubuntu developers are not
yet ready to push the modified
GNOME Software into the main
Xenial branch, and there still a few
problems that have to be solved
before that happens.
Source:
http://news.softpedia.com/news/g
nome-software-now-available-inubuntu-1 6-04-with-a-ppa498977.shtml

O

ne of the most interesting
LUBUNTU 1 6.04 LTS
things that came out of the
(XENIAL XERUS) H AS B EEN
latest Ubuntu Developer Summit
was the fact that Canonical wanted PORTED TO RASPBERRY P I 2,
to ditch the Ubuntu Software
WITH LXQ T
Center for GNOME Software. This
information has been very well
uilt with the Ubuntu Pi Flavour
received by the community, which
Maker tool, which we've
is not terribly fond of that
introduced you to last month,
particular application.
made by the Ubuntu MATE team,
the Raspberry Pi 2 port of the
In fact, users have been asking upcoming Lubuntu 1 6.04 LTS
why GNOME Software isn’t
(Xenial Xerus) operating system is
available in the daily build of
currently in development stage;
Ubuntu 1 6.04 LTS. The launch of
but at least we see some progress
this OS is planned for April 201 6,
with the implementation of LXQt
so there isn’t much time left. It
in Lubuntu.
turns out that they have been
working on this transition, but it’s
"A nice experiment made by wxl
not as simple as you might think,
from the Lubuntu QA Team:
and a lot of things depend on it.
running Lubuntu Xenial Xerus on a

B
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Raspberry Pi 2, with LXQt desktop.
Made with Ubuntu Pi Flavour
Maker," said Rafael Laguna in the
brief announcement. "And that’s
all. Enjoy Lubuntu in your new Pi.
Remember this is just an
experiment, it may be unstable."
If you want to test the Lubuntu
1 6.04 LTS (Xenial Xerus) operating
system on your Raspberry Pi 2
single-board computer, you will
have to download the
experimental image, install it on an
SD card, upgrade to the Xenial
branch, and then follow the
Lubuntu Wiki guide to install the
LXQt packages.

the differences in what people are
doing and their motivations is what
makes the Ubuntu community
strong. “There is a great
misconception that Ubuntu is what
I want," he said. "It’s not. Ubuntu is
the son of what many different
diverse groups want. What we
struggle and fight for is the
framework for collaboration that
enables people to get what they
want.”

running Snappy Ubuntu Core, you
are running the same code
everywhere.
Source:
http://www.cio.com/article/30256
30/linux/scale-1 4x-day-1 shuttleworth-delivers-the-grandvision-for-ubuntu.html

U BUNTU PHONE OTA-9
U PDATE RECEIVED WELL BY
U SERS, N EXUS 1 0 PORT TO
B E REMOVED

He then talked about how
Ubuntu is innovating with changing
times: they developed Snappy to
offer a much more secure,
sandboxed Ubuntu experience to
ccording to Mr. Zemczak, the
enable people to use Ubuntu in a
OTA-9 update has been
Source:
variety of devices such as drones,
received well by Ubuntu Phone
http://linux.softpedia.com/blog/lu Internet of Things, artificial
users, but only those lucky enough
buntu-1 6-04-lts-xenial-xerus-hasintelligence, smart cars, etc.
to get it in the first hours.
been-ported-to-raspberry-pi-2However, the rest of them should
with-lxqt-498995.shtml
During the Q&A session,
be able to upgrade to OTA-9 in the
someone asked about people
coming hours, so make sure you
taking Ubuntu and creating their
keep checking for updates
own
stuff
with
it,
by
which
I
SCALE 1 4X, DAY 1 :
regularly.
assume he meant derivatives.
SHUTTLEWORTH DELIVERS Shuttleworth said that he thinks
"OTA-9 phased upgrades are in
that’s a good thing; people can do progress! Just in a little while all
THE GRAND VISION FOR
whatever they want to do with
U BUNTU
users should be able to upgrade.
Ubuntu. Then he also mentioned
We're also really happy that the
that
they
are
trying
to
avoid
ark Shuttleworth praised the
update itself was so nicely
Snappy having the fragmentation
differences and diversity in
welcomed," says Łukasz Zemczak,
Android
is
experiencing,
because,
the Ubuntu community. He said
Ubuntu Foundations, in his daily
irrespective of where you are
full circle magazine #1 05
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report, which we received as an email dated January 27, 201 6.
As reported a few days ago, the
OTA-9.5 hotfix will enter final
freeze on January 29 and will land
for all Ubuntu Phone users on
February 1 0, 201 6. Then, the devs
can finally concentrate all of their
efforts on the next major update,
OTA-1 0, which will bring even more
cool features.
Source:
http://news.softpedia.com/news/u
buntu-phone-ota-9-updatereceived-well-by-users-nexus-1 0port-to-be-removed-499523.shtml

M
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Written by Lucas Westermann

fter the Christmas holidays,
it’s usually time for me to take
stock of my work equipment
(computers and servers), and see
what I can do while I’m still on
holidays to make life simpler. This
time around, I wanted to configure
an internal Bind9 DNS server, so I
can use internal domains for
accessing servers, virtual
machines, NAS, other computers,
and so forth. Since my test area is
Ubuntu 1 5.1 0 on Vagrant, I’ll cover
all the steps (including the steps
for Vagrant).

STEP 0: CONFIGURE
VAGRANT BOX
If you’re setting up Bind DNS on
a standalone device, or on a virtual
machine that is already configured,
you can skip this step. Personally, I
think Vagrant is a wonderful way
to test configurations, but I will be
migrating the Bind9 DNS server to
an Intel NUC, once the new skylake
models are available.
vagrant box add ubuntu/wily64

This command adds the official
Wily Werewolf 64-bit Vagrant Box
to your system. You can skip this
and go straight to the init, but I
prefer to have local copies of
certain base boxes, as I spin up a
lot of vagrant boxes.
vagrant init ubuntu/wily64

This will initiate a Vagrantfile
that uses the ubuntu/wily64 box
from above. If you haven’t added
the box using the box add
command, it should work anyway
(as this is an official image). If not,
you may need to supply the URL
(see the Further Reading section
for a link to the webpage).

stuck with a host-only network, as,
if my computer isn’t running,
neither is the VM (nor do I need to
have access to the test DNS from
anywhere else).
Lastly, you’ll want to start the
Vagrant box with:
vagrant up

STEP 1 : I NSTALLING
I recommend installing 3
packages - bind9, bind9-docs, and
dnsutils. Bind9 and the -docs
package are important, as they will
be the actual DNS server. Dnsutils
contains a bunch of useful tools for
debugging DNS.

You’ll also want to set up a
private network IP (if you plan to
STEP 2: B ASIC
actually use the DNS). To do so,
edit the Vagrantfile, and edit the
CONFIGURATION
line that reads ‘config.vm.network
“private_network”’. The IP can be
Open/edit the correct file using
pretty much anything you’d like
the following command:
(provided it isn’t already in use). If
sudo vim
you’re going to use the DNS
/etc/bind/named.conf.options
outside the host computer, you’ll
need to instead set up a
If you’d prefer to use something
public_network. Since this is a VM, I
like emacs or nano, substitute vim
full circle magazine #1 05
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for that. If you’re doing this in a
graphical environment, you’re
welcome to use anything you
prefer. If working in Vagrant, you’ll
be limited to CLI. I’ll also be
referring to line numbers. If your
vim isn’t displaying the numbers,
you can toggle them with the
command “:set number”.

STEP 2 A: FORWARDERS
Since we’re focusing on internal
connections, any outside IPs (which
will be requested from this server
as well) can be safely called from
existing DNS. This is what Bind9
calls “forwarders” - they are
essentially the IP addresses of the
DNS that should be checked, if the
domain isn’t contained in the local
copy. I’d recommend using the
Google DNS, but if you want to use
your ISP’s, you simply need to
know the IPs of them. Find lines
1 3-1 5 (that starts with //
forwarders {), and make it look like
this:
forwarders {
8.8.8.8;
8.8.4.4;
};
contents ^
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The big change here is replacing
line 0.0.0.0; with 8.8.8.8; and
8.8.4.4; (the IPs for Google’s DNS).
Also, make sure you uncomment
the entire block. If you’re using
vim, use a quick ‘Esc’ (to leave edit
mode), and then save and quit
with: :wq

STEP 2 B: SETTING UP ZONES
You’ll need to open a new
configuration file:
sudo vim
/etc/bind/named.conf.local

sections of the IP (so ignore the
last number).
Also, select a local domain
you’d like to configure. I selected
lswest.local, simply because it
won’t interfere with existing
domains (if you use google.com,
for example, you will not be able
to reach the google homepage).
Now, in the named.conf.local
file, you’ll need to add the lines
shown top right.

The section that reads “inaddr.arpa” is required for a DNS
IPv4 reverse lookup. For more
This file should be largely
empty (on a fresh install, at least). information, see the wikipedia link
Before we can make any edits, we in Further Reading. Type indicates
need to know what our IP address whether the DNS is a master
(primary), or a slave (secondary).
is. Typically, it’s something like
While this is a complicated
1 92.1 68.0.X, or 1 92.1 68.1 .X (for
distinction to fully understand, for
internal networks). To find out
the time being it’s safe to assume
what your IP address is, you can
any local Bind9 DNS zone will be a
run the command ‘ip addr‘. If
you’re running Vagrant, you’ll have master. The ‘notify no;’ on the
a few different interfaces - find the internal IP indicates whether or
one that uses the private or public not zone notifications are to be
sent to slaves when changes occur.
network IP you added to the
As this is a master without slaves,
Vagrantfile. If you’re at a physical
it’s not technically necessary.
computer with multiple internet
However, since this is for all IP
connections, I’ll have to assume
addresses in the network, it’s
you know which IP to use. It’s
useful to include (to avoid issues
important to note only the first 3
down the line).
full circle magazine #1 05

zone “lswest.local” {
type master;
file “/etc/bind/db.lswest.local”;
}
zone “0.168.192.in-addr.arpa” {
type master;
notify no;
file “/etc/bind/db.192”;
};

Now we need to create the db
files we refer to in the file. To start
with, I’ll focus on the local domain.
sudo cp /etc/bind/db.local
/etc/bind/db.lswest.local

Now we’ll need to open and
edit the file:
sudo vim
/etc/bind/db.lswest.local

The file should look like the
following:

9

The changes we’ll need to
make:
• In line 5, we’ll need to change
localhost. to domain. (a fully
qualified domain name - fqdn) So,
since the domain is lswest.local,
the line will read “lswest.local.”.
Make absolutely sure there is a
trailing period.
• Also in line 5, we’ll need to edit
“root.localhost.” This is actually an
email address (but without an @).
It isn’t terribly important what you

contents ^
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put here, but I’d recommend at
least using your username. So
root.localhost. becomes
“vagrant.localhost.”.
• You’ll need to also edit line 1 2 to
be the domain name you chose in
1 . So we would edit this to read
“lswest.local.”

SUBDOMAINS
Now is the time to actually
create subdomains. I’m going to
focus only on A records, and
possible CNAME (canonical name)
entries. MX Records are also
common, but I don’t know how
often you’ll want to really
configure MX records in a local
network. If you do, the process is
the same.

The file will then look like the
text shown top right (from line 1 6
onwards).
The lines that start with a semicolon are comments, and serve to
just make the file more readable.
As you can see, you point the
CNAME to the fqdn of another
server. As you can probably figure,
this is because CNAMEs are simply
aliases.

STEP 3: REVERSE LOOKUP

This step is optional. If you’re
not planning to do reverse DNS
checks on IPs (to find domains),
you can skip this. However, it’s
good practice, and may come in
useful.
First, we must copy the default
db.1 27 file:

I’m going to create 2
subdomains - nas (fqdn:
sudo cp /etc/bind/db.127
nas.lswest.local), and web (fqdn:
/etc/bind/db.192
web.lswest.local). One will point to
the physical NAS I have in the
Once done, open the file. It will
network, and the other will point
look similar to the db.lswest.local
to the vagrant box I use for web
file from above. We need to make
development.
the following changes:
I’ll also set up a CNAME entry - Line 5: change “localhost.” to the
vagrant, which I’ll point at the web fqdn from earlier.
subdomain.
Line 5: Change root.localhost to
the email you used earlier.
full circle magazine #1 05

; A Records
nas
web

IN
IN

A
A

192.168.0.4
192.168.33.10

CNAME

web.lswest.local.

; CNAME Records
vagrant

IN

Line 1 2: change “localhost.” to the
fqdn from earlier.
Delete line 1 3 (the pointer). We’ll
be replacing this entirely later.

vim).

We now need to add the
entries. After line 1 2 (the NS line),
add the following line:

It’s now time to start the Bind9
server. To do so, run the following:

4
IN
PTR
nas.lswest.local.

The 4 is the last number of the
IP address from db.lswest.local.
Since this is a reverse lookup for
1 92.1 68.0, we need only the last
digit. It is also why I left out the
web value, as the IP is
1 92.1 68.33.1 0 - if I wanted to
reverse lookup this, I’d need to set
up a zone for 1 92.1 68.33. However,
as my Vagrant installs don’t
generally survive long, I don’t find
the effort necessary. The CNAME
doesn’t get a pointer, as it’s not
assigned to an IP.
Save and close the file (:wq in

10

STEP 4: RUN SERVER, AND
CONNECT

sudo service bind9 start

Now you need to enter the DNS
on the machine you want to use it
from, this could be done in the
network manager in Ubuntu, or
wherever you may configure a DNS
on the OS of choice.
Use the IP for the server we
configured earlier.

STEP 5: TESTING

Once your DNS is configured,
you should be able to connect to
one of your servers using the
domain name. If your browser
initiates a search instead of pulling
up the webpage, make sure you
manually add http:// before the
contents ^
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domain.

If the domain doesn’t resolve
properly, you can check it using
dig. The command for that looks
something like this:
dig nas.lswest.local
@192.168.15.3

The @ indicates the DNS to
check. If you’ve already changed
your DNS IP, it shouldn’t be
necessary. If, however, you’re not
getting the results you expect, it
may be useful.

STEP 6: LOGGING

If you run into issues, you’ll
want to enable logging. AppArmor
technically has a rule for bind9
already, but the folder in /var/log
doesn’t exist. You’ll want to do the
following:

I hope this article is interesting
for anyone who may, like me, be a
web developer (or just simply run a
lot of devices on their internal
network). If you enjoyed the
article, and have any questions,
issues, or suggestions, feel free to
reach out to me at
lswest34+fcm@gmail.com.

FURTHER READING
https://atlas.hashicorp.com/ubunt
u/boxes/wily64 - URL to the Wily64
box.
https://en.wikipedia.org/wiki/Reve
rse_DNS_lookup - Reverse Lookup
wikipedia article.
http://askubuntu.com/a/469867 Permission errors with Bind9

sudo mkdir /var/log/named/
sudo chown bind:root
/var/log/named/
sudo chmod -R 775
/var/log/named/

That should result in a log file
(once the service was restarted). If
not, you’ll want to check the third
link in the Further Reading section.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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THE FULL CIRCLE
WEEKLY N EWS
EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporter
(Arnfried) is posting regular
news updates to the main Full
Circle site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.
Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.

A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!

11

contents ^

W

H OW-TO

P yth on I n Th e Rea l World Pt. 63

Written by Greg D. Walters

elcome back to our Real
World programming series.
Last time, we programmed the RPi
to turn on and off an LED when a
button was pressed. Very simple,
but this got us started. This month,
we will do another simple project,
a traffic light simulator using 3
LEDs, one Red, one Yellow and one
Green. For the most part, the code
is very similar to what we used last
month, so you shouldn’t have any
problems. If you have any

questions, I suggest you look at
last month’s article which should
answer any of your concerns.

LED, and the orange wire controls
the red LED, since the red wire is
already being used.

First, let’s look at the schematic
and the breadboard (below right).

You should also know that the
pins being used should work on a
RPi v1 a/b, RPi v1 b+ and RPi v2b.

Notice that the wire colours
correspond to its ‘job’, with the
exception of the orange wire. The
red wires supply 3.3 volts. The
green wire controls the green LED,
the yellow wire controls the yellow
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The red LED cathode is

12

connected to GPIO 1 7 (Physical pin
1 1 ), yellow LED cathode is
connected to GPIO 23 (Physical pin
1 6), and the green LED cathode is
connected to GPIO 22 (Physical pin
1 5). The Anodes of all three LEDs
are connected to one side of 220
Ohm resistors and the other sides
are connected to a common 3.3
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VDC. We don’t need the ground
voltage for this particular project.

def setup():
GPIO.setmode(GPIO.BCM)

# Numbers GPIOs by physical location

GPIO.setup(RedLedPin, GPIO.OUT)
# Set the 3 LedPins
Since I’ve driven only in the U.S.
GPIO.setup(YellowLedPin, GPIO.OUT)
I’ve based the simulation on our
GPIO.setup(GreenLedPin, GPIO.OUT)
traffic patterns. Long red light (1 0
GPIO.output(RedLedPin, GPIO.HIGH)
# Turn off LEDs
seconds), green light is usually
GPIO.output(YellowLedPin, GPIO.HIGH)
shorter than the red light time (8
GPIO.output(GreenLedPin, GPIO.HIGH)
seconds), and the yellow light is
fairly short (2 seconds). These
physical pin numbers, be sure to
def LEDLoop():
values are currently hard coded in change the GPIO.setmode() line in
print "Green On..."
the time.sleep() function calls. Feel the next routine (top right).
GPIO.output(GreenLedPin,0)
free to change them as you see fit.
time.sleep(8)
As I mentioned above, the
GPIO.output(GreenLedPin,1)
Now let’s start working through GPIO.setmode needs to be
print "Green Off..."
the code.
print "Yellow On..."
changed from ‘GPIO.BCM’ to
‘GPIO.BOARD’ if you want to use
GPIO.output(YellowLedPin,0)
#!/usr/bin/env python
the physical pin numbers instead
time.sleep(2)
# Traffic Light Simulator
of the BCM numbers in our
GPIO.output(YellowLedPin,1)
# Written by G. D. Walters
definitions. The next three lines
print "Yellow Off..."
set the LED pins as output pins,
print"Red On..."
#-------------------------GPIO.output(RedLedPin, 0)
and then turn all three LEDs off to
time.sleep(10)
import RPi.GPIO as GPIO
start the program by setting the
GPIO.output(RedLedPin,1)
import os
output value to HIGH.
print "Red Off..."
import time
import datetime

#-------------------------RedLedPin = 17
YellowLedPin = 23
GreenLedPin = 22

The first 9 lines are our
standard import statements and a
few comment lines. The next three
lines define the BCM pin numbers
for our LED pins. If you wish to use

def destroy():
GPIO.output(RedLedPin, GPIO.HIGH)
GPIO.output(YellowLedPin, GPIO.HIGH)
GPIO.output(GreenLedPin, GPIO.HIGH)
GPIO.cleanup()
if __name__ == '__main__':
setup()
try:
loop()
except KeyboardInterrupt:
will be executed.
destroy()
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#
#
#
#

mode as output

The LEDLoop routine is very
simple:
• We print on the console “<color>
On…”,#
• Turn the LED on by setting the
output value to 0 or low,
• Sleep for a designated period,
• Set the output value of the pin
back to 1 or high,
• Then print that the LED is now
off.
This is then duplicated for the
Yellow and Red LEDs. The loop()
routine simply forces the

led off
led off
led off
Release resource

# Program start from here

# When 'Ctrl+C' is pressed, the child program destroy()
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LEDLoop() routine to be called
over and over until the user hits
<CTRL> C on the RPi keyboard.

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

def loop():
while True:
LEDLoop()

rian Douglass has created a

fantastic app for Ubuntu Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

The destroy routine and the
main loop are the same as last
month. We simply set all the LED
pins to high, turning them off, and
then call GPIO.cleanup().

I NSTALL
Either search for 'full circle' in the
Ubuntu Touch store and click
install, or view the URL below on
your device and click install to be
taken to the store page.

I’m not sure that we could make
a much simpler program to do
what we need to do.
If you want, you could duplicate
the 3 LEDS and make an
intersection simulation before
next time.

https://uappexplorer.com/app/
fullcircle.bhdouglass

Next time, we’ll have something
that is a bit more challenging. Until
then, happy programming.

Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.
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Written by Elmer Perry

Li breO ffi ce Pt.5 6 - E xport To PD F

ortable Document Format
(PDF) is a handy way to share
documents when you need to
control what the reader can do
with the content. You can make
the document where others
cannot change or even comment
on the contents of the document.
You can secure the document so
that the reader cannot even read
the document without a password.
You can create electronic forms for
collecting data, and you can create
document consistency by
embedding the fonts used in the
PDF document. Most importantly,
PDF is portable, working on most
platforms and in most web
browsers.

PDF E XPORT

LibreOffice allows you to
export most documents as PDF,
including text documents,
spreadsheets, drawings, and
presentations. There are a lot of
options for the exporting of
LibreOffice documents to PDF –
today is an overview of these
options. In later articles, we may
look at more specific applications
and uses.

The Range options allow you to
specify what content is included in
the PDF. You have options for All,
Pages, or Selection. All will export
the entire document into the PDF,
while Pages allows you to select
what pages are exported. You can
enter a range of pages (1 -6),
individual pages separated by a
semicolon (3;6;8), or a combination
of ranges and pages (1 -6;3;1 01 2;40;52). Selection will export
full circle magazine #1 05

You can export a document as a
PDF using the last selected options
through the Export Directly as PDF
button on the default toolbar. But,
in order to change the options
before saving the document, it is
much better to use the File >
Export to PDF menu option. This
displays the PDF Options
dialog.The dialog gives you six tabs
with all the options for exporting
your document as a PDF.

G ENERAL TAB

only the currently selected
contents of the document.
The Images options tell
LibreOffice how you want it to
handle the image quality. You can
chose the Lossless compression
option, but only if you have a good
reason (eg, your document is a
photo art journal). Lossless
compression will greatly increase
the file size. JPEG compression is a
better choice, and a quality of 90%
works for most photo images. The
image resolution will depend on
the end media for your PDF. If you

are designing for online screen
viewing a DPI of 75 or 1 50 is good.
However, if there are plans for
printing, a DPI of 300 or greater is
better. Keep in mind that a higher
DPI means a bigger file size.
The Watermark option is
simple. Checking this option will
create a transparent overlay on
each page of the text in the text
box. Use it to indicate a draft or
sample.
The General options relate to
the overall structure of the PDF.

The General tab gives you most
of the common options.
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The Hybrid PDF option embeds
the Open Document Format (ODT,
ODS, ODP, etc) into the PDF
document. This allows you to
directly open and edit the PDF
document in LibreOffice. After
making changes, you can save it as
a LibreOffice document or export
it back to a PDF. Selecting this
option disables the Range options
since it will embed the entire
document.
The Archive PDF / A-1 a option
embeds all the fonts used in the
document in accordance with ISO
1 9005-1 . This is a good option for
creating archival documents or for
preserving the use of special fonts
or layouts. This is helpful if you
need to print from a computer that
does not have the same font set as
the one you created the document
on.
The Tagged PDF option allows
you to create a tagged PDF
document. Tagged PDFs contain
document structure information
and can allow the document to
reflow better on some screens.
The embedded structure is also
used by some screen readers. A full
discussion of tagged PDFs is
beyond the topic of this article, but
keep in mind that all that

document structure information
increases the size of your
document.
The Create PDF form option
allows you to create a PDF form
that people can fill out on a
computer. This type of document
could help you to collect data for
use in other places. The Submit
Format allows you to chose how
the form data is stored. There are
four options:
PDF – the whole document with
the information filled in is saved as
a PDF.
• FDF (Forms Data Format) – only
the data for the controls in the
form are saved.
• HTML – form data is saved in
HTML format.
• XML – form data is saved in XML
format.

notes in the document, as well as
exporting automatically inserted
blank pages. Finally, View PDF
after export will open the newly
created PDF after it is exported.
This will allow to you see how the
finished document looks.

I NITIAL VIEW TAB
The Initial View tab lets you set
how the document will display
when it opens.
The Panes options allow you to
select which reader panes will
open when you open the
document. You have the options to
open the thumbnails and page,

bookmarks and page, or just the
page itself. You can even set the
document to open on a page other
than page 1 by using the Open-onpage setting.
The Magnification options let
you control the magnification of
the document when it opens.
Default just uses the default
magnification setting of the
reader, while other settings allow
for whole page (Fit in window),
page width, or zoom to fit the text
and graphics in the window (Fit
visible). You can also manually
define a custom Zoom factor.
The Page Layout option

There is also a checkbox to
allow for duplicate file names in
the forms controls.
The Export bookmarks option
will create bookmarks for table of
contents and outline paragraphs. If
you are curious about the outline
paragraphs, you change their
setting at Tools > Outline
Numbering. You can also export
LibreOffice comments as PDF
full circle magazine #1 05
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determines how the pages will
display. Again Default just uses the
reader's default settings; however,
you can chose to have it display
just one page at a time. When you
scroll to the end of a page, it will
jump to the next page. If you chose
instead to select the Continuous
option, when you reach the
bottom of one page, the top of the
next page will start scrolling as
though the pages were fixed
together. The Continuous Facing
works the same way as continuous,
but displays two columns of pages
like an open book.

U SER I NTERFACE TAB
The User Interface tab controls
the options for the way the actual
window responds when the
document is opened.
The Window Options control

how the window will respond to
the opened document. You can
have it fit to the size of the first
page, center the window on the
screen, or open the window in
fullscreen mode. You can also
chose to display the document
title in the title bar.
The Transitions option relates
only to the export of a
presentation to PDF. If you select
the option, the LibreOffice page
transitions are exported into the
PDF document.
The User Interface options
control whether to hide the
menus, toolbar, and reader's
control tools. You may chose to
hide some or all of these
depending on the way you want
the document used. Keep in mind
that the user can reverse all these
options.
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The Bookmark option allows
you to control whether all or just
some of the bookmark levels are
exported to the document. You
can select to export all or specify
the level to which to export the
bookmarks.

LINKS TAB
The Links tab sets how internal
and external links are handled
within the document. All of these
options assume the reader is
capable of handling the different
options.
The General options control
how links are referenced.
Exporting the bookmarks as
named destinations allows other
documents to directly reference
the bookmark. When you convert
document references to PDF
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targets, the PDF will reference a
PDF document of the same name
as the referenced document. This
setting assumes you will convert
all referenced documents to PDFs.
If you want to move a document
with external links to other
computers, you can export URLs
relative to the document;
otherwise, they are exported as
absolute links, requiring you to
recreate the entire folder and file
structure on the other computer.
With the Cross Document Links
options, you control what program
is used to open any links to
documents. The Default option will
use the operating system’s default
program for opening the linked
document, but you can specify that
the document is opened with the
current reader, or with the
operating system's default
Internet browser. Whatever you
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select, you have to assume that
that feature.
the selected program will open the
file-type referenced. So, if you
If you entered and confirmed a
have a mix of document types,
password for permissions, the
your best option is Default.
Print, Changes, and Contents
settings are activated. The printing
options indicate whether the
SECURITY TAB
reader is allowed to print the
You set what the reader can do document without entering the
with the document on the Security password. The Changes section
tab.
The Password button lets you
set two different passwords, one
for opening and the other for
permissions. To set either of the
passwords, enter the password in
the appropriate text box, and
repeat in the second box to
confirm. Leave the text boxes
blank to not create a password for

controls what changes are allowed
without having to enter the
password. The Contents settings
control whether the reader can
copy the contents of the
document, or access the
accessibility tools, without the
password.

D IGITAL SIGNATURES TAB
The Digital Signatures tab lets
you sign the document with a
certificate. Digital signatures is a
topic beyond the scope of this
article, but know that you can add
a digital signature when needed.
The tab provides text boxes for the
password and other information
related to the certificate.
LibreOffice gives you many
options for exporting your

full circle magazine #1 05
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document to PDF. We have
covered, in a passing overview, the
options available. PDF is a good
way to send a document to others
without making it easy for them to
edit the document. You never
know when you might need it, as
you could get a request for a
document in PDF format.

Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Written by Theo van Oosten

n the early days of computers, a
company called Digital
Equipment Corporation (DEC, first
bought by Compaq, today part of
Hewlett-Packard) created their 32bit VAX (Virtual Address
eXtention) computer as an
upgrade from the 1 6-bit PDP/1 1
(Programmable Data Processor)
computer. It uses openVMS as its
operating system. In the steelmaking company where I work, a
large number of these computers
were used to control the
manufacturing process. We use
(VAX-) Pascal as the standard
programming language, and a
home-brew computer
interconnection program called
HDN.

M i g ra te From VAX/VM S To Li n u x Pt.1

knowing their way around in VMS
is quickly diminishing, and it is
getting harder to find replacement
parts for failing hardware. The
hardware could be replaced with
emulators like Charon-VAX
(although, I have bad experiences
with frequent, but random, errors
on Charon-VAX, I will explain these
in one of the following articles),
but expert programmers cannot be
emulated. So, in the end, even
these reliable computers will have
to be replaced. But replacing these
computers will take a lot of time
and money, as the functionality
must be migrated to another

We are not the only
manufacturing company that used
these computers. There are
thousands of VAX's sold all over
the world. Because a VAX/VMS
computer is so reliable, there are
today, after more than 25 years,
still a large number of them in use,
including some in the company
where I work. But after more than
25 years, the number of people

operating system.

process during the migration,
which will cost even more money,
not to mention the damage to the
WINDOWS?
reputation if you fail to deliver in
time, or at a lower quality than the
Because most people are
customer is used to. Also the
familiar only with Windows, this
reliability of Windows is
would be the logical choice. But
questionable: most programs
the migration from VAX/VMS to
delivered with the operating
Windows is time-consuming,
expensive and complex, due to the system are an integrated part of it,
which might lead to a complete
different way the operating
system works, and despite the fact system breakdown if just one
that Windows NT is based, loosely, component fails, and viruses are a
problem in itself. Protection
on the VMS predecessor, RSX, as
against them takes a huge part of
used on the PDP/1 1 . This
complexity increases the chance of the systems resources, and, in our
case, on one occasion, was even
disruption of the manufacturing
itself the cause of a total system
breakdown. Mandatory updates of
the operating system to patch
security leaks require a frequent
reboot of the computer, causing a
loss of production time. And
finally, some experts are quietly
admitting that they are slowly
losing the battle against the flood
of new viruses....

WHAT ABOUT THE
DATABASE?
full circle magazine #1 05
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Besides the different way
programs are written for Windows,
there is another problem: DEC
created on their VAX/VMS
computers another type of
database compared to the
relational databases used today, a
network database named DBMS32
(DataBase Management System
32-bit). In this case, the word
'network' does not refer to a LAN
or the Internet, but to the internal
organization of the data. The
different types of data are not
linked to each other through a
relation, but by a double-linked
list. Finding the first/next/last
member of a set is lightning fast,
because you only have to follow
the link – instead of reading all
records in the database to see if
the relation is satisfied. When you
migrate a VAX/VMS system to
Windows, you also have to migrate
from network databases (if you are
using it) to relational databases.

LINUX!
As I was thinking about an
alternative way to migrate, it
appeared to me that VAX-Pascal is
largely compatible with Free
Pascal. And the way Linux works is
largely compatible with VAX/VMS.

So I decided to try to convert our
programs to Lazarus/Free Pascal,
but found that there is no
replacement for DBMS32. So.... I
created one. It’s written in
Lazarus/Free Pascal, and includes a
GUI replacement for DBQ – the
database client interface program
used to read or enter data. Not
entirely up to spec yet, but that
will improve over time. I replaced
the interconnection program HDN
by a set of programs: one to send
and one to receive the data,
operating system independent,
and with the data in readable form,
formatted in XML-style, while using
folders as send and receive
buffers. To be used by our
applications, I created an API equal
to that of HDN, so the applications
remain untouched. This causes less
risk of failure, because they just
needed to be linked to another
library.

I T IS NOT GOING TO BE
EASY...
The way I state this might
suggest that migrating a VAX/VMS
system to Linux (in my case Linux
Mint 1 7) is a walk in the park. This
is, unfortunately, not true. There
are third party programs used on
full circle magazine #1 05

VMS systems which have no Linux
replacements. You would have to
rewrite those programs based on
their functional/technical
description, or find another way to
deal with the functions they
perform. There are libraries
offered by DEC included in VMS
with no counterpart in Linux, such
as FDMS (Forms Display
Management System). And then
there are technical functions used
in VMS with no apparent
replacement in Linux, such as
eventflags and logicals. In the
following articles, I will go more in
depth to describe how I replace
these, and other functionality such
as mailboxes (IPC), and how to deal
with Asynchronous System Traps,
DCL and file version numbers.

I F YOU NEED HELP...
Because my company is not the
only one that wants to migrate
away from VAX/VMS, I am willing
to provide DBMS32 and the other
replacements as open source
under the GPL license to anyone
who needs it. And I am offering to
assist in the conversion of your
VAX/VMS programs. This will be
magnitudes cheaper than a
complete re-engineering and
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conversion to Windows and there
is a much smaller chance of
disruption of the manufacturing
process during the migration, as
the conversion is almost 1 -on-1 .
I think the advantages of a
network database would be
interesting for new projects as
well. If there are enough people
who would like to know more
about using network databases
and their (dis)advantages, I will
write some articles on how a
network database is organized and
how it can be used in comparison
to a relational database.

N EXT MONTH
In the next article, I will explain
what eventflags are, what they are
used for, and why they are so
important to dedicate an article to
them.

After keeping VAX/VMS systems
running for 30 years, Theo needed a
new challenge and started from
scratch with Linux to re-do every
mistake he made all over again. You
can email Theo at:
info@theovanoosten.nl
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U s e G n u Ca s h

Written by Tom Lombardy

G

nuCash is in the repositories
and easy to install. Once
installed, if you want to download
transactions posted to your bank
account, there are a few relatively
easy steps to take.

currency, you have the option to
go Back, Forward or Cancel.
Going Forward takes you to the
New Book Options.

Once you open GnuCash, click
on File>New File, or use Ctrl+N to
open the New Account Hierarchy
Setup window.

The Accounts, Budgeting,
Business and Counters tabs I
believe are more Business
orientated. The Budgeting tab is
greyed out so there are no options
on that tab. So, for my personal
finances, I did not choose any of
the options and went Forward to
the next screen, Choose accounts
to create.

As you can see, Common
Accounts is selected and the
Category Description states that
most users will want to use this
option. From here, click on
Forward to Setup selected
accounts.

It will help you set up a set of
GnuCash Accounts for your assets,
liabilities and different types of
income and expenses you may
have.
On this screen, you can choose
Cancel or Forward to the next
screen, Choose Currency.
This is where you set up your
accounts. When you click on an
account and highlight it, you then
double-click on Account Name to
specify the name you wish to
assign to the account: ie., My
Banking Account. With the account
highlighted, you can also double-

The Choose Currency is selfexplanatory, as you can choose the
currency of your area.
Once you have chosen your
full circle magazine #1 05
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click on the Opening Balance (refer
to your latest bank statements for
these figures), and you will be able
to start with your Opening
Balance. If you fail to enter an
Opening Balance, or Account
Name, you have the option of
entering them when you open the
the register screen after setting
everything up.

Next, you can set up your online
banking by clicking on Tools, online
banking setup.

Here you will need the
following: the bank code of your
bank, the user ID that identifies
you to your bank, and the Internet
address of your bank's online
banking server. You must contact
your bank for this information.
Clicking on Forward brings you When you have this information
to the Finish Account Setup screen. click on Forward
Here, once again you can go Back,
Apply or Cancel the actions.
Clicking on the Apply option brings
you to the Save As window.
Here you create a folder for
your files and give it your
preferred name.
After saving your account, your
banking accounts are listed under
Assets.

Clicking on Forward brings you
to the Start AqBanking Initial
Assistant.

After clicking on Start
AqBanking Wizard, your next
screen allows you to Create User
and Accounts in order to download
banking data for GnuCash.
I will not actually create
another bank account as I have
everything already set up with my
banks.
Once this is finished, go to your
personal banking institution, find
where you can download your data
for your account, and choose
Quicken.
After downloading your file,
click on File>Import OFX/OFX...
and navigate to the downloaded
Quicken file.

At this point, if you do not wish
to download your online banking
file, you can just use your GnuCash
as a regular check register.
full circle magazine #1 05
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Highlight the downloaded file
and press enter. This will bring up
the Generic Import transaction
matcher window, which allows you
to reconcile your transactions with
three options: A = imports
transactions you have not entered
in your register; U+R allows you to
update and reconcile the
transaction, and R reconciles the
transactions you have entered in
your register. Once you have
selected your preferences, click
OK. You will then be brought back
to your account register and see
your imported transactions have
been updated with a “c”.
I hope this will help with initial
setup of your accounts.
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I n k s ca p e - P a r t 4 5

Written by Mark Crutch

f you've read the previous few
articles, you should now have an
idea of how to use Live Path
Effects, and just how capable they
can be. Rather than go through
every remaining effect in detail,
I'm going to spend the next couple
of articles presenting a whistlestop tour of those that are present
in version 0.48. These are all also in
0.91 , and their respective
interfaces are the same between
the two versions, so these
examples should apply to either
version. In each example, I'll
present the original skeleton path
in red with the results of the
applied LPE in black.

CONSTRUCT G RID

A simple LPE to start with, the
Construct Grid effect does exactly

as its name suggests – it constructs
grids. It uses the first three nodes
of the skeleton path to define two
sides of a parallelogram, extending
the shape to form a grid of cells
based on the Size X and Size Y
values in the UI.
The “live-ness” of this effect
can make it useful if you want to
drag the nodes around to produce
the correct perspective by eye,
rather than by creating a grid with
numeric angles.

When you apply this effect to a
shape, Inkscape draws one or more
sine waves that try to fill the
available area. The waves can be
modulated in both frequency and
amplitude by the parameters you
set in the UI, and their angle, base
frequency, and the amount of
bend applied to them, are set by
on-canvas handles.

To get a feel for the effect,
draw a closed path, then add the
LPE. You'll see your path replaced
by a squiggly line that
approximates the original shape.
H ATCHES (ROUGH )
Now switch to the Node tool (F2),
This is a peculiar effect. Its main and towards the middle of your
shape you should see four handles
use is to simulate hand-drawn
– two circular and two diamondscribbles as a fill inside your
(usually closed) path, but given the shaped. If you see fewer than four,
then it's simply because some are
rough nature of the results – it
even says “rough” in the LPE name positioned on top of others. Drag
them around until all four are
– I don't think it really needs the
visible.
huge number of fine-grained
controls it presents. For most
The four handles represent the
people, the key to using this LPE is
to just use the on-canvas controls end nodes of a pair of vectors
and a few of the main UI elements, (which, confusingly, aren't actually
without getting too bogged down drawn as lines), and are used to set
the main parameters for the
in the many other options.
effect. In each case the circular
full circle magazine #1 05
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node is the reference point – drag
that one, and the corresponding
diamond will move in sync. This can
be used to move the nodes to a
clearer part of the canvas, or to
some specific reference point in
your drawing. Moving one of the
diamonds adjusts both the angle
and frequency of the sine waves
used to fill your shape. The other
diamond sets the amount of bend
that is applied. It has an effect only
if the Bend Hatches checkbox is
ticked in the LPE dialog, so, if you
don't want the additional
curvature applied to your sine
waves, simply uncheck that
control.

contents ^

HOWTO - INKSCAPE

Of the remaining controls in the ensure that they all look slightly
dialog, it's probably the top two
different from one another.
that have most effect: Frequency
Randomness is used to adjust the
amount of variation that is applied
to the base frequency, whilst
Growth causes the frequency to
increase from left to right. Set
both values to zero if you want to
use just the base frequency that
you've set with the on-canvas
handles.
With these basic controls, it's
possible to produce a variety of
effects, running from the
appearance of a hand-drawn
scribble, to a simple shaped sine
wave:

The final checkbox, “Generate
thick/thin path”, is worthy of a
mention too. With this enabled,
two sets of paths are created that
Many of the settings in the
move in and out of sync with each
dialog have pictures of dice next to other on each half-cycle of the
them. Despite their appearance,
underlying sine wave. The specifics
they don't actually set the fields to of the synchronisation between
random values. Rather, these are
them are set by the last few fields
buttons which change the seed
in the UI. These two sets of paths
value in the random number
are actually joined at each end,
generator that's used to produce
forming a single path that can be
the corresponding value in the
filled to give a calligraphic effect to
hatching algorithm. Their only real the hatching:
use is to ensure that one copy of a
shape using this LPE has a
I NTERPOLATE SUB-PATHS
different hatching pattern to
another copy – if you need to
This effect requires that your
produce many similar shapes then skeleton path is made up of two
clicking a few of the dice will
full circle magazine #1 05

sub-paths (if it has more than two,
only the first and last ones are
used by the LPE). Typically, subpaths are created by combining
multiple paths – through Boolean
operations such as removing one
path from another object that
completely encloses it, or by
breaking a single path into smaller
sections by hand using the Node
tool's Delete Segment or Break
Path buttons. Consider this simple
example of one star inside another,
drawn separately, then combined
using Path > Combine (CTRL-K).
When the LPE is applied, a number
of additional sub-paths are
created, interpolating between the
two sub-paths of the skeleton:

effects that you can easily create
with this LPE:

The Trajectory control in the
LPE dialog shows the familiar
group of four controls for setting a
path. These allow you to specify a
path along which the rendered
sub-paths will be spaced, allowing
for more than simple linear
projections.

The total number of sub-paths
in the final result is set using the
Steps parameter. Increasing this,
and turning the inner sub-path a
little, demonstrates the sort of
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With the Equidistant Spacing
checkbox ticked, the sub-paths will
be placed evenly along the
trajectory path. Un-check that,
however, and their spacing will be
determined by any additional
nodes in the path. The nodes split
the path into segments, then the
total number of sub-paths is
distributed between the segments.
For example, a trajectory with
three nodes will result in two
segments, each holding half the
rendered sub-paths. Moving the
middle node, therefore, results in
the spacing of the paths being
adjusted – one half bunched
together and the other half spread
out.

By creating a trajectory with
the same number of nodes as the
Steps value for the LPE, each subpath is tied to a single node,
letting you accurately position

them simply by moving the nodes
around. This example uses Steps=5
together with a trajectory path
that has five nodes, to
demonstrate this possibility:

Next time we'll look at the
remaining effects that are
available in 0.48: Pattern along
path, Ruler, Stitch sub-paths, and
VonKoch.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/

full circle magazine #1 05
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Written by John (Eros) Kerr

alentine's Day is coming, and I
can't think of a better excuse
to show a less serious side of
LaTeX – while at the same time
showing some of the fancy font
formatting that we can do.

M a ke A Va len ti n es Ca rd I n La TeX

\usepackage{color}

The package gcard is what
formats the page, calligra gives us
the handwriting font, graphicx
gives us pictures, and color lets us
change the colour of the font. You
The advantage of creating your may notice the two spellings of the
word colour. In LaTeX we have to
own card is that you can avoid
do as the Americans do and use
going to the store and reading all
their spelling of color for colour. I
kinds of cards that are a bit too
mushy for your taste, and resorting refuse to capitulate in the rest of
to picking the best one from a bad the column.
lot that just is ¨not you¨. He/she
Within the document, we need
would appreciate receiving
the {\calligra } command when we
something that you made the
effort of making yourself. The card want the handwriting font to
appear. To change the font colour
can also be used to create a card
to red and change the size of the
for any event or holiday.
font:
Creating any kind of card is
made easy with this template that {\LARGE \color{red} * }
makes use of the gcard.sty, which
Here is something that can trip
would be installed on your
you
up and causes errors.
computer as part of the texlivelatex-extra file.
See the asterisk in the the code
above? That is where your text
The preamble contains these
and it can be many
commands to make things happen: goes,
paragraphs if you like. But that last
“ } “ can get lost or deleted if you
\usepackage{gcard}
\usepackage{calligra}
are not careful, especially when
\usepackage{graphicx}
you add more text formatting code
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\\documentclass[12 pt, letterpaper, portrait]{article}
\usepackage{gcard}%calls for the package to make the card
\usepackage{calligra} % added for handwriting font
\usepackage[T1]{fontenc}
\usepackage{graphicx}
\usepackage{color} %added for font color
\begin{document}
\begin{frontcover}
\begin{center}
\includegraphics{1.png}\\
{\LARGE \color{red} %temporary command to change font
colour
{\calligra to a special person.}}
\end{center}
\end{frontcover}
\begin{insideleft}
\end{insideleft}
\begin{insideright}
{\LARGE \color{red} %temporary command to change font
colour
{\calligra Happy Valentine's Day!}}
\end{insideright}
\end{document}

like:
{\calligra Happy ...}

When we run it all together it
looks like:
\LARGE \color{red}
{\calligra Happy ...}}

Notice the double }} at the end.
If you forget to put those in, or
one } gets deleted, your document
will not compile properly.
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My file for the Valentine's day
card is shown above.
You will have four small pages
on one side of the paper. You will
have to fold it to make your card.
Depending on font sizes and what
kind of card you are making, you
may have to adjust things with
centering or no centering on the
page.
That is how to make a greeting
card in LaTeX.
contents ^
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AR D U I N O

Th e Brewd u i n o Pt.1

Written by Ronnie Tucker

recently took up homebrewing
and wondered how I could
incorporate the Arduino. I think I
can. I thought I’d use this article to
show my thought process and
planning before I even pick up an
Arduino, or think about writing
code.

THE B ASIC I DEA
Ideally, I need to keep my
fermentation vessel between 1 825°C. The spare room that I’m
using is sitting at about 1 6°C, so I
need to find a way to control the
heat around the vessel. I can’t put
anything in the vessel as this may
introduce contamination, or break
the seal on the vessel. I’d also like
some lighting to let me see what’s
happening inside the vessel since
the vessel is semi-transparent. Any
other info would be a boon.
OK, so I know what I roughly
want. Let me look at the pros and
cons of the various things.

VESSEL H EATING

This is the one thing I really
need, so this is the priority. Initially
I was looking to modify something
that’s readily available like a
heated car seat, or a pet blanket.
Mainly those as they’re low power
(around 1 2V), but after more
reading I’d be as well sticking with
what I have just now, a reptile heat
mat that I can wrap around the
vessel. I just need to find a way to
control the heat mat.

TEMPERATURE READING

of controlling the heat mat. After a
lot of research I think a relay switch
is the best option. With this I can
use the Arduino’s 5V to trigger the
switch to an on/off position. I’ve
not used switches much, but the
gist behind them is to put the live
wire from the heat mat through
the switch, which will break the
circuit, then, when required,
energise the switch with 5V to
complete the circuit and the heat
mat will come on.

I’m not worried about this as it is
never hotter than about 32°C, it
will take a while to heat the liquid
inside, and, conversely, it’ll take
quite a while for the liquid to cool
down. Hence, while the heat mat
may be on for a little while it
should need switching on/off only
every few hours, at least, so it’s
not like I’d be switching it on and
off every few minutes. Well, that’s
the theory. We’ll see how that pans
out in the practical phase.

Controlling the heat mat, I’ll
probably use the figures from the
DHT module with code something
like:

LOGGING

Like I mentioned earlier, I can’t
put anything in the vessel so I’m
going to have to make do with a
reading from the outside. I know I if temperature <19
can accomplish this with the DHT
turn on heatmat
temperature/humidity module that else if temperature is >22
turn off heatmat
I’ve used before. I’ll just have to
make sure it’s firmly touching the
My thinking for the 1 9 and 22 is
outside of the vessel but not too
fixed as it will need to be removed that the final temperature should
be around 20°C to 21 °C, but either
before cleaning the vessel.
way anything from 1 9-25°C is fine.

TEMPERATURE CONTROL

Now that I have those two
nailed, I can try to figure out a way
full circle magazine #1 05

Another reason for the not-sostrict heating in my pseudo-code is
that the heat mat will take about
20-30 seconds to reach full heat.
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I still have a spare ESP WiFi
module, so I can probably do like I
did with my plant monitoring
project where I send the data to
ThingSpeak. I’ll probably note the
temperature and humidity over
day and time. Of course, day and
time may mean I need to use a realtime clock module. Unless
ThingSpeak tags on the day/time.
Not sure. Can’t remember if they
do.
I could also log the brightness
of the room using an LDR, but the
light level has no bearing on the
contents ^

ARDUINO - THE BREWDUINO
brew, so scratch that.

I’d like to have an alert system
where I can get an SMS/email
should the temperature go
haywire. This is a possibility using
ThingSpeak and Twilio, but is not
something I’ve tinkered with
before and will leave this to the
end as it’s not critical.

LIGHTING
Lighting is not critical, and will
be manually controlled, so I’m not
too worried about this. This will be
a strip of 1 2V LED lighting with a
transformer and a switch. No need
for the Arduino to control the
lighting. One major consideration
for the lighting though is that it
must be removable as the vessel
has to be bleached sterile after
use. I’ll probably just attach the
light strip(s) to the vessel with
some tape or blu-tac.

ADDITIONS

camera switches to night vision
mode, will the IR lights reflect off
the vessel and bleach the image
making it useless? Not sure, but
that’s something to test.
A further addition could be an
LCD screen. If I put the screen near
the top of the vessel, and within
range of the camera view, I could
monitor the temperature
remotely.

I’ll more than likely include the
LCD screen as it’s a nice visual
guide to the reading from the DHT
and I can compare that against the
thermometer that’s stuck to the
side of the vessel.
NEXT MONTH: The project
begins with the LCD screen, DHT
and WiFi modules.

As a quick visual-at-a-glance aid,
I may add some LEDs to show if the
temperature is within a certain
range. Maybe between 20-22 could
be a green LED with 25+ being red.
Maybe 1 9 or less is a yellow LED.

CONCLUSION
The basic idea of controlling the
temperature of the liquid with a
heat mat is definitely possible.
Same with the logging. Shouldn’t
be a problem.

The lighting (to see inside) isn’t
a necessity and not Arduino
I have a spare IP camera that
doesn’t seem to move up/down or controlled, so it’ll be left until last
left/right properly, so I might use it probably. Same with the IP camera.
Nice, but not a necessity, and not
to view the fermenting vessel by
Arduino controlled.
putting it near the top rim to see
in. My only query here is that if the
full circle magazine #1 05

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
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Clou d D i stros

Written by S. J. Webb

fter seeing the varying
aspects of the Chrome OS, are
there other Linux distros running
off the cloud? Perhaps there could
be an open source solution to the
closed OS by Google.
There are four Linux Distros
that come to mind: Chromixium,
Papyros, Solus, and Apricity.

CHROMIXIUM :
Chromixium is a popular one
based off Ubuntu 1 4.04.
Essentially, there has to be more

than Chromixium. Chromixium was
previously reviewed in Full Circle
Magazine. It is gaining steam as a
full distro, while staying true to the
Chrome OS formula. It uses the
Ubuntu Software Center.
Chromixium picks up where the
Chrome OS drops off. My only
criticism is that Chromixium is too
Chrome OS-like in nature.
Chromixium is a distro that has
some solid groundwork. It deploys
Grive for the Google Drive access.
If you wanted a good feel of a
Chromebook, then distro hop to
Chromixium for a try. The
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Chromixium DE mirrors the first
screenshots from the first Chrome
Cult. You can see the shelf and
profile. Chromixum uses Openbox
and a few tweaks to get the
Chrome OS feel.

PAPYROS:
Then there is Papyros. This
distro had varying names since its
inception. However Papyros is
based off Arch Linux and it has yet
to reach Alpha testing. It will be
done soon per the website. It
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utilizes Google’s Material Design
guidelines. The DE has roots in KDE
and Gnome.
The purpose to Papyros is
simple but beautiful.
"Our vision for Papyros is building
a Linux operating system that is fun
and easy to use for the average user.
We’re doing this by building an
operating system that gets out of
the user’s way, integrates with cloud
services and web technologies, and
converges across devices and form
factors.
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Their current work in progress

is:
• A rolling release architecture
with atomic upgrades and
rollbacks.
• Integration with web apps such as
Gmail, Inbox, and Evernote.
• A simple and easy-to-use desktop
environment.
• A cross-platform app
development framework based on
QtQuick.
• A file manager and settings app
for the OS.
This distro could use some
backers to help support it. They
are using Bountysource Salt as a

crowdfunder. Their future goals:
intelligent notifications, user
account restrictions, application
bundles, sandboxing, and, if
possible, convergence.
The developer is running a
Google+ account and infrequent
blog. The last activity about the
distro is from September 201 5.
There is no Papyros Installer. You
can run a Papyros Shell if you have
Arch Linux already downloaded. I
truly hope this distro can get the
momentum to be successful like
Chromixium.
Papyros Linux could possibly
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use the Arch User Repos (AUR).
The AUR is a strong PPA listing for
Arch Linux. The AUR has Dropbox,
ownCloud, Grive, and other cloud
repositories. This would allow
Papyros to have access to many
cloud services utilized by the
Chromebook Ecosphere, while still
being open source. I am hoping to
do a better review of Papyros
when they develop their installer. I
prefer not to install Arch Linux just
to try out a new and developing
OS.

SOLUS:
Solus is not based on any
previous work; it is built from the
ground up. It is the most mature
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and established distro for minimal
design. The DE layout is similar to
previously mentioned OSes. It has
its own DE called Budgie. Solus
uses the Gnome Software Center,
it favors the Gnome ecosphere.
The PPA manager is eopkg. The
Solus Project has an active forum
and blog. Budgie can be installed
on Linux Mint and Ubuntu. It uses
an applet called Raven (below left).
Raven is a notification and
customization center. It does the
following per Solus Project:
• Calendar access and Media
Center Controls.
• Manage application and system
notifications.
• Customize the Budgie DE (below).
• Quick access to power options
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CHROME CULT
and system settings.

Solus runs well on my older HP.
The OS feels minimalist while still
offering the functionality of a full
DE. Solus has an established forum
that supports new users very well.
The only issue with Solus is the
Gparted Partition Installer. I had to
redo the install steps a couple of
times to get Solus fully installed.
However, this is a small complaint.
The install was less than 30
minutes. Only a 64-bit architecture
is offered at this time.
Solus just finished beta testing.
I am thinking of running this OS for
a while on my older HP at home.
The main goals of Solus are below:
• Solus Operating System is
completely free and open source.
We leverage fantastic open source
software to enrich the end-user
experience
• We focus completely on the
desktop, and believe users deserve
a first-class desktop experience.
No phablets here!
• We believe an operating system
should get out of your way, and do
its job as well as it possibly can
when it is needed
Each release of Solus will be
supported for 2 years. And there

will be 4 updates each year for the
OS.

APRICITY:
And now for Apricity. This is
another Arch Linux derivative. It
has a strong community too. The
developers are based out of
Chicago, IL, USA. It is currently in
beta testing. I will review this
distro next month.

SJ Webb is a Linux Hobbyist and

Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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Wri te For Fu ll Ci rcle M a g a zi n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
34

contents ^

W

L I N U X L AB

3 D P ri n te r B u i l d P t . 2

Written by Ronnie Tucker

ith this part of the Fisher 1
build, we give it some sides.
There are two sides and a back.
The back, which comes later, is
where we access the SD card slot
and have the power jack. Again,
you need to peel the protective
covering from both sides of the
two side panels. Endstops are little
microswitches that your carriages
will touch and signal that they’ve
reached their end point. These
microswitches are held in place
with small cable ties. The two side
panels are held in place by several
screws.

steel ball on the sides of the
rods.
carriages goes between the pair of
strips on the rods.
The effector is a tricky
This one (below left) is a bit of a
contraption to build. It involves
boring job. You get two sheets of
trying to tighten screws that are
EFFECTOR ASSEMBLY
strips. You pop the strips out of
quite well hidden, so having angled
the sheet in pairs. Again, you
screwdrivers, or Allen keys, would
The nozzle that’ll heat up and
remove the protective covering
melt the plastic filament sits inside be helpful here. Took a bit of
from both sides of each rod, then
fiddling, but I managed it in the
screw the rods together. Then do it the effector (below right). The
end with just straight screwdrivers
effector is attached to the rods.
all five more times. You get six
and with Allen keys that I normally
rods—each made up with a pair of Hopefully, now you can see how
the nozzle will move, or be aimed. use on my bicycle.
strips screwed together.
The carriages will, independently,
Again, you’ll need the callipers
go up/down with the effector
The rods should be carefully
dangling from the carriages on the to check the total width of the
pried apart at the edges and the
sides with more steel balls

CONNECTING RODS
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screwed in place. You might need a
metal file for this to shorten the
screws and bring the steel balls
back a touch.

E XTRUDER ASSEMBLY

you fine-tune that ‘setting screw’ I
mentioned. You should be able to
gently hold the filament between
your fingers and still have it pull
through. This takes a bit of
tweaking, but can still be tweaked
when it’s in its final place.

The extruder, as you might have
Next time, we’ll be fitting the
guessed, extrudes your PLA plastic
hot end (nozzle) and putting the
filament. It feeds the filament
down a tube into the heated
nozzle.

other electronic bits in place.

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

REPRAPPRO RIP
As this issue is released it
appears that RepRapPro
have ceased trading and
closed their store.
This means there are no
spares/help for RepRapPro
devices.
While this is a great printer it
is now unavailable, and I
don't recommend you buy a
second hand RepRapPro
printer since there is no
support nor spares available
for these printers now.

Yet again, more peeling of
plastic. The extruder uses up the
last motor in the box of bits and
requires you to insert the tiniest of
screws into a winding mechanism.
So make sure you have a really
small Allen key handy.
You also need to make the idler
lever, which you can think of as
being a setting screw to set how
tight, or slack, you will be pulling in
the filament.
Once you put all the pieces
together, you are left with the final
extruder. With this made, you can
now cut a piece of filament and try
putting it into the assembly, then
winding the mechanism to pull the
filament into the assembly and out
the other end. This is also where
full circle magazine #1 05
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U B U N TU P H O N E S

Written by Ronnie Tucker

OTA-9

• Better translation coverage
• Performance boosts,
his list is only a highlight of the improvements with regards to UI
hangs
few changes available in this
update. Please check the detailed
And many many more...!
changes for all the changes
included in this OTA.

T

I MPORTANT FEATURES
• New 1 5.04.3 framework
• Media-hub exposure of mpris
playlist support
• Update the bluetooth stack to
Bluez5
• Media consumption (audio) in
scopes
• Smooth refresh of scopes
• Custom ringtone support
• Sound notification on low-battery
state
• Download of arbitrary file types
in the webbrowser-app
• Convergence changes for the
ubuntu-ui-toolkit

D ETAILED CHANGES

Commitlog:
http://people.canonical.com/~lzem
czak/landing-team/ota/ota9.commitlog
Milestone bug list:
https://launchpad.net/canonicaldevices-systemimage/+milestone/ww02-201 6

B UGFIXES
• Camera fixes for proper
resolution support
• Location-service improvements
full circle magazine #1 05
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P yth on Pla yg rou n d

Written by Greg Walters

projects for the curious
programmer" helped a little bit,
but my eyes kept going back to
those robots, no matter how hard I
tried to ignore them.
Once I got into the book,
however, my concerns were
assuaged. Glancing at the table of
contents, I was pleased by the
project-based format. Part 1 deals
with iTunes Playlists and
Spirographs, neither of which
really excited me. Part 2, however,
caused my heart to start to beat
faster. The three projects cover
Conway's Game of Life, Generating
Musical Overtones, and Flock
Python Playground: Geeky
simulations – all of which are of
projects for the curious
interest to me for various reasons.
programmer
Continuing down, my eyes were
By Mahesh Venkitachalam
drawn to "Part 5: Hardware
November 201 5, 352 pp.
Hacking". My heart skipped a beat
Publisher: No Starch Press
(which at my age isn't really a good
ISBN: 978-1 -59327-604-1
thing) and I immediately jumped
directly to the first page of the
hen I first got this book, I
section. Sure enough, it was talking
was very excited. When I
about using the Raspberry Pi and
opened the mailer, I was somewhat the Arduino. I was in heaven. I was
concerned by the cover… two
smiling so hard that my face
robots with laptops on a teeter
started to hurt.
totter. The sub-title "Geeky

W
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Reading through chapter 1 2
(Introduction to the Arduino)
immediately showed that this
author has a very good command
of Python and his code is very
tight. He explains his code in what I
call "the breakout format", which is
where the code is presented as a
block or snippet, then is explained
step-by-step. No Starch uses a very
nice template that allows the
author to put graphical call-out
numbers (numbers inside a small
black circle) next to a line of code,
and then the author simply
references the number in the
explanation section. This makes it
very easy for the reader to quickly
refer to a line of code that they
need more explanation for.
There are a total of 1 4 projects
that include ASCII art, particle
system simulation, as well as using
OpenGL. The author also teaches
how to use popular and important
Python libraries like numpy,
matplotlib, pygame and more.

book on Python and I completely
agree. While each project has indepth explanations of not only the
code but also the background
needed to understand the project,
it is far above the level of a
beginning programmer. If,
however, the reader has some
background in other high level
languages and has a good grasp of
Python syntax, then this is a great
book to move beyond the normal
command-line type programs. The
projects presented are all realworld usable and very relevant to
today.
The bottom line is that this is a
book that belongs in every Python
programmer’s library. I have to
give this book 5 out of 5 stars. No
Starch has a great book on its
hands.

The author states right from
the beginning, that this book is not
intended to be the reader's first
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M yG i ca AT V5 82 T V Box

Written by Charles McClom

O

ld desktop systems are great
for repurposing as a KODI
entertainment system server. Stick
a few multi-terabyte drives in an
old dual or quad core computer,
with a $30 fanless video card with
HDMI out, along with Ubuntu and
KODI installed, and you have a nice
1 080p capable entertainment
system. This kind of solution might
work great for a basement, but if
you’re looking for a more elegant
solution for your living room or a
second room, a much smaller
device like the MyGica ATV582 is a
better solution.
When you open the packaging,
the first remarkable thing you’ll
notice is how small the ATV582 is,
it’s less than an inch high, and is
shorter than the length of an
average cell phone. The front
bears a couple of lights, a network
status light, and a power status
light, as well as an infrared sensor.
On the right hand side of the
ATV582 is a single microSD slot
and two USB ports. The back of the
device has a gigabit LAN port, an
A/V port, an HDMI port, DC power
port, and the Wi-Fi antenna. Also

included with the ATV582 are an
HDMI cable, a very short A/V cable
(which is really more of an adapter
than a cable), an AC adapter, and a
remote control. The unit also
comes with a small quick-start
guide and a warning not to return
the device to the store, but to call
MyGica if you have issues.

Setup was as simple as turning
the box on, pulling the plastic tape
out of the remote so the battery
made contact, and stepping
through 4 screens: welcome,
language, screen and network. We
chose to connect our unit to a LAN
connection because we have a lot
of large media files stored on
another server.

Linux-based KODI network server
(shared via SAMBA). The unit ships
with an older version of KODI 1 4.2,
but it works just fine for playing
media.

The remote control is fairly
simple at first glance. It has the
following buttons: power on/off,
volume up/down, home,
The ATV582 is based on the
select/enter, navigation
ARM Cortex A9 AMlogic S802-B
While we didn’t have any 4K
left/right/up/down, mouse on/off,
quad-core processor with the Mali- media files to test the unit’s 4K
back, stop, play/pause, fast
450 octa-core GPU. There is 1 GB of claims, it was more than capable of forward, rewind, and menu. But if
RAM onboard, and 8GB of flash
playing the 1 080p MKV files (some you flip the remote over, there is a
memory. The ATV582 we
as large as 44GB) stored on our
small qwerty keyboard on the
purchased came with Android 4.4
Kitkat.
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other side. The remote control
comes with a USB receiver that
must be plugged into the ATV582
for the remote to work. MyGica has
included a QR code in the setup
guide for Android phone users
who’d prefer to use their phone as
a remote control for the device.

the remote is all but useless for
certain Android games, you’ll need
a real mouse to play some games.

inconspicuous that it’s barely
once. At just over $1 00 CDN, it
noticeable if you put a couple of
ended up being a fantastic deal for
picture frames or other
the price.
decorations next to it. Hidden in
The left side of the ATV582 is
the ATV582 are the powerful quadused to vent heat. Because the
core processor and octa-core
unit is so small there are not a lot
graphics processing unit. They’re
of ports, only 2 USB, 1 of which is
much more powerful than the
taken up by the remote’s IR
ATV520E cousin, and play large
One of the improvements the
receiver. Having a single usable
size high-definition files just fine.
ATV582 has over its baby brother, USB port is this unit’s biggest
The remote with keyboard was
Charles is the author of Instant
XBMC, and the project manager of a
the larger-sized dual-core
shortcoming. For those of you who more than expected, and other
not-for-profit computer reuse
ATV520E, is the MyGica user
like to wall-mount everything, the than gaming usage, works very
project. When not building PCs,
interface. Instead of trying to
ATV582 also lacks any kind of holes well for all other tasks. While
removing malware, and encouraging
simplify a desktop with many icons, on the bottom for mounting, which KitKat is old by Android standards,
people to use GNU/Linux, Charles
has a blog at charlesmccolm.com.
it has that cleaner look of a touch
means you’ll have to resort to
it’s been rock stable the past few
interface, KODI is in fact one of the using something like 3M velcro
weeks – requiring a reboot only
first applications on the home
tape to mount the unit. Both of
screen. The ATV520E also came
these issues are really a direct
with a simpler keyboard-less
result of the unit being so small.
remote. The keyboard on the flip
MyGica could have provided some
side of the ATV582 remote takes a way to mount the ATV582, but it
little bit of getting used to. If you
would have likely been a touch
find yourself unable to type using thicker.
the keyboard characters, press the
function key to switch between
The size of the ATV582 is also
the character sets. The mouse on
its best feature, it’s so

full circle magazine #1 05
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Viva ld i Browser Beta 2

Written by Ronnie Tucker

ivaldi is a new web browser
from one of the two original
developers of the Opera browser.
Opera is still with us, but as Jon
says:
“The browser we once loved has
changed its direction. Sadly, it is no
longer serving its community of
users and contributors — who
helped build the browser in the
first place.
So we came to a natural
conclusion: we must make a new
browser. A browser for ourselves
and for our friends. A browser that

is fast, but also a browser that is
You may need to adjust that
rich in functionality, highly flexible, command depending on the
and puts the user first. A browser version number in the filename by
that is made for you.” - Jon
the time you read this.

I NSTALL
Installing is easy. Simply visit
https://vivaldi.com and click the
download button on the front
page. From there, choose your
32/64-bit DEB file. When
downloaded, double click on the
DEB to install, or install using:
sudo apt-get install vivaldibeta_1.0.344.37-1_amd64.deb
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You start Vivaldi using your
usual Unity/desktop launcher.
On first start, Vivaldi will ask if
you want to import data from
another browser, and what data to
import.

LAYOUT
Vivaldi has a familiar layout.
Very top-left is the Vivaldi icon.
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This is your menu for File, Edit,
View, etc. Top of the screen has
your tabs, navigation buttons with
URL and quick search, and below
that is (if you want it displayed)
your bookmarks bar. You’ll also
notice what looks like skip
forward/back as you’d see in a
media player. These are what
Vivaldi calls fast-forward and
rewind buttons. Can’t say I’ve used
them much, if at all, but apparently
they’ll take you to the first page of
the site and predicts the next
page.
The left side of the screen has a
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The first thing I noticed was
that pages loaded much faster in
Vivaldi than in my usual Firefox.
And I mean almost instantly. My
broadband isn’t the greatest, so
having a page load within a
second/two was a revelation to
me.

light/dark theme, and access to the
numerous keyboard shortcuts that
it uses.

The settings are divided into
categories such as appearance,
tabs, privacy, etc. Or, if you want
the full Monty, you can click
‘Display All’. The settings window
has a search feature which is handy
for those hard-to-find features.
Everything is in here such as
default start page, showing/hiding
various bars/menus, interface
scale, default font type/size,

Vivaldi has a few tricks up its
sleeve, though. A nice touch is that
the navigation bar and tab will
take its colour automatically from
the page you’re on (above). For
example, as I write this in Google
Docs, the tab and bar is blue.

TWEAKS

Initially, I thought Vivaldi was a
complete rewrite of a browser, but
it turns out that it uses Chromium
SETTINGS
as a foundation. Which is no bad
thing as this allows the user to
Clicking the cog icon at the very install Chrome extensions. I tried
bottom left of the screen displays this out by, of course, installing
the Vivaldi settings (left).
AdBlock.
panels.

vertical bar (above) which has
buttons for (top to bottom)
bookmarks, downloads, notes, and
an icon to let you add additional

Yes. Notes. You can click the
notes icon and save quick
reminders for yourself. The ‘+’
button allows you to attach
images, or files, to your note. Very
handy.
full circle magazine #1 05
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If I switch over to my Gmail it
will turn red.
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A handy feature in Vivaldi is tab
grouping. What I’ve been doing is
opening both my Gmail accounts
and grouping them into one tab. If
you look closely at the red tab in
the photo, you’ll see that it has
two red bars above it. That’s two
tabs in one. I can click that to
switch between (in this case) two
tabs. But there’s more! You can
also right-click on the tab and click
‘tab stack’ and it will split the
screen to show your tab group.
Couple that with the notetaking bar and you’re set!

PRIVACY
I’m no privacy expert, so can’t
comment on its security, but I’d
have to assume it is pretty secure
if it’s using Chromium as its
underbelly.

M ISSING :
What Vivaldi doesn’t do, but I
hear is coming, is the
synchronisation of bookmarks
between devices. This doesn’t
bother me as I use EverSync to go
between (formerly Firefox) Vivaldi
on my desktop machine, Firefox on
my laptop, and Chrome on my
tablet and phone.

second beta), but it certainly
seems faster and I love the tab
grouping and screen-split features.
Give it a try. You’ve nothing to
lose.

You can click the Vivaldi button
and choose File > New Private
Window, and it will display a new
window with a yellow icon (with a
Flash is also missing from
black key) and with a black URL bar Vivaldi.
Whilst some replies in their
(below).
forum recommend installing
Chrome (to use its plugins), or to
install the Pepper Flash package(s)
from the repos. I couldn’t get Flash
to work with Vivaldi after trying
both ideas.

CONCLUSION :
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I have to say, I’m pretty
impressed with Vivaldi. I wasn’t
expecting much (since it’s only the
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Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
full circle magazine #1 05
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Compiled by Gord Campbell

I want to install VLC Media
Q Player.
What password can I
use to authenticate?

A

(Thanks to

grahammechanical in the

Ubuntu Forums) When we install
Ubuntu, we are asked to set a
username & password. That
username is the name we log into
Ubuntu with, and that password
authenticates logging in with that
username.

for "Windows/Android/Chrome
OS" to put it in discovery mode.
Then use the bluetooth GUI to
search. (Gord adds: This answer
applies to most Bluetooth devices,
irrespective of OS.)

Q

I have an old PC that has
Windows XP which I rarely use.
I want to try Ubuntu OS.

A

A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

(Thanks to SlidingHorn in the
Ubuntu Forums) From what
I'm reading, you'll have to make 2
edits:
In /etc/apache2/sitesavailable/000-default.conf, find
"DocumentRoot" and change to
the following:
DocumentRoot
/path/to/new/root

If the old computer has 1 GB
In /etc/apache2/apache2.conf,
of memory, it should be fine
with Xubuntu, Lubuntu or Ubuntu find:
Once we login to Ubuntu, we
can do most tasks without needing Mate. If it has 51 2 MB of memory, <Directory /var/www/html/>
and the video does not steal any of Options Indexes
to authenticate the action. But
FollowSymLinks
that memory, it should run
there are certain tasks that only
AllowOverride None
we are allowed to perform, and for reasonably well. If it has less than
Require all granted
51 2 MB, it will not provide a happy </Directory>
those tasks we are asked to
authenticate the action. We enter experience.
And change the
the password that we created
"/var/www/html" to the absolute
Skills you need: how to boot
when we installed Ubuntu.
from DVD or USB, how to deal with path to your desired home
directory.
partitions.
Can't pair bluetooth keyboard
logitech k480 with Ubuntu
How can I configure Apache2
1 5.1 0.
to serve pages from a folder
under
my Home?
(Thanks to jeremy31 in the
Ubuntu Forums) You need to
press the button on the keyboard
full circle magazine #1 05
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A

Q

TOP QUESTIONS AT
ASKUBUNTU
* What is the meaning of the `|`
symbol in the shell?
http://goo.gl/wME5NU
* I installed a program by getting
its source code, and then running
`sudo make install`; how to make
`apt-get` know about it?
http://goo.gl/7Vcpl0
* Why does ^C, ^V, etc. appear in
the terminal when I use the
Ctrl+character keyboard shortcut?
http://goo.gl/AA09Ov
* List all recently changed files
(recursive)
http://goo.gl/wV3e1 Z
* How to charge my Ubuntu
phone's battery off my Ubuntu
laptop's battery?
http://goo.gl/GilP6p
* Where should I keep my personal
files while keeping the pathname
short?
http://goo.gl/zMfj1 Z
contents ^

Q&A
* How to enter password only once
in a bash script needing sudo
http://goo.gl/fLesVY
* Can I minimize a window into a
box on Unity?
http://goo.gl/LTRICz
* How to set the default program
to open a certain file-type in a
certain folder?
http://goo.gl/1 BQ1 LK

TIPS AND TECHNIQUES

THE FULL CIRCLE
WEEKLY N EWS

WHY?

W

hy would someone install
Linux with an "LVM" disk,
when they don't know what that
means?
Why would someone install
Linux with a software RAID, when
they have not spent the time
required to understand how
software RAID works?
Why would someone assume
that their computer will work
forever, when their car won't?

A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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S e c u ri t y

Written by Walter Samsberg

PG P Wi th Th u n d erbi rd An d En i g m a i l

sudo apt-get install
o understand how PGP email
thunderbird
works, you first need to know
the basics of public/private key
Next, install enigmail
encryption, a.k.a. RSA
cryptography (if you already know, sudo apt-get install enigmail
you can skip this paragraph). It
might be compared to a P.O. box
Assuming that you now have
where everyone can see your box
your email setup in Thunderbird,
number, but only you know the
launch the application and go to
combination to get in. In an RSA
Menu>Enigmail>Setup Wizard.
public/private key pair, the public
key can be used to encrypt
information; once encrypted, the
only thing that can decode the
message is the private key. PGP is
the email application for the RSA
concept. I can send my friend an
encrypted message without going
to the trouble of driving to their
house with a flashdrive to agree on
a key. All my client software has to
do is find my friend's public key
from a server, and the rest is a
breeze.

To get started on this, you first
need to have Thunderbird
installed. If not, go ahead and
install it by typing in a terminal
window:

Proceed by setting up your PGP
key.
Enter an 8 digit passphrase to
encrypt your private key.
full circle magazine #1 05

Your computer will then
generate a 4096-bit RSA keypair.

Certificate somewhere safe such
as a flash drive.

After generating the key, follow
You're almost done! All that
through by saving the Revocation remains now is backing up your
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private key, and publishing your
public key to a few servers so that
your friend’s email client can
automatically download it.
To backup your private key, go
to (in Thunderbird)
Menu>Enigmail>Key Management.
Select your key and then, under
Key Management, go to
File>Export Keys to File, and click

Export Secret Keys.
Again, I recommend that offline
storage would work best such as a
flash drive. Now, to export your
public key to a keyserver, without
closing the Key Management
window, select your key and go to
Keyserver>Upload Public Keys.
There you should see a list of
keyservers to choose from. Any of
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the three will work fine, but it also
wouldn't be a bad idea to upload
your public key to all of the servers
that are listed.
Now you are all set to start
receiving encrypted PGP emails!
Also, when you go to send
someone an encrypted message,
Thunderbird will help you find
their public key on one of the
servers. With a key length of 4096bit, this totally makes your private
messaging military grade.
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D I RT Sh owd own

Written by Oscar Rivera

t long last, there is a true, fast,
adrenaline-pumping racing
game available for Linux! That
game is DIRT Showdown,
developed and published by
Codemasters. It was originally
released for Microsoft Windows,
Xbox 360, and PlayStation 3 back in
201 2. Then, in 201 4, it was
released for Mac OS X, and, most
recently, released for Linux,
August 201 5.
DIRT Showdown can be
purchased and downloaded for
Ubuntu through Steam for $1 4.99
(recent Steam sales have had it as
low as $2.99). The game is much
more than a racing game as it also
contains two other playing styles,
which are named Demolition and
Hoonigan. There are different
types of Races, just like there are
different types of Demolition and
different types of Hoonigan
events. The Racing events and the
Demolition events are pretty much
self-explanatory. The Hoonigan
events can be obstacle courses
where you must complete tricks
within a limited time, or they can
be courses in which you must

smash different color boxes in the
right order (as specified by the
computer), also within a limited
time. These are all part of what's
called the Showdown Tour. In
addition to the Showdown Tour,
there are two other modes of
playing:
• Online Multi-Player (which at this
time is almost non-existent due to
a lack of online players)
• Joyride in which you are the only
car and free to roam anywhere you
want, but must collect challenges
in the form of a scavenger hunt.
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Aside from the Multi-Player
aspect of the game, exhilarating
thrills abound as the game has the
potential to appeal to a wide
variety of gamers, from the casual
to the hard-core.
Playing DIRT Showdown is
pretty straightforward. It is
recommended that you play using
a game controller, which is what I
did with my Razer Onza controller
and it was flawless. You can also
play the game with
mouse/keyboard if you so desire.
There really isn't a tutorial but
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anyone who's played a car racing
game will feel right at home with
this one; it's not too difficult to
pick up.
The responsiveness to controls
has had zero lag in all of the tracks
I've played. Initially in the
Showdown Tour's Pro tournament,
there are only a couple of tracks
available, but by racing these
tracks and placing in one of the top
spots, more tracks become
available. After completing all
tracks in the beginner's “Pro”
league, then you can advance to
the “All-Star” league followed by
the “Champion” league. Finally, the
“Legend” league is the top tier
which is unlocked only after
completing all previous three
leagues. Like most racing games,
you have the choice of which car to
choose and you can also level up
your car by purchasing Power,
Handling or Strength upgrades
with the prize money you're
awarded from previous races. In no
time you can have a fast, powerful
car that can take more than a
beating. Alternatively, you can also
purchase other cars as they
contents ^
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become unlocked by winning
various events.
Although the game was
optimized for AMD GPUs, and I'm
using an Nvidia GTX 960, I've had
zero problems with the game so
far. The graphics have been
fantastic, and there have been no
glitches running the game at near
maximum settings. There is a builtin Benchmark that gave me an
average of 51 frames-per-second
so performance has not been an
issue yet and I've already been
playing the game for quite a while.
There have been a few scenes that
almost left me in awe with the
multi-layered sunsets displayed
behind the race tracks. The sound
is your standard high-octane, fullthrottle sonic experience. Sound
effects of idling engines revving up
to maximum speed in time,
followed by the wearing down of
brake pads and rubber tires as they
burn in unison with the pavement
in a struggle to stop the fast
moving vehicle before it collides
with another car, is like music to
my ears. The voice narrator is a
sportscaster who gives you the
play-by-play while managing to add
a bit of humor from time to time.
The soundtrack is your typical rock
soundtrack found in most racing

impressive. The sound is great, and
the overall playability makes it feel
like it was originally developed for
Linux which makes DIRT
Showdown a game worth getting.
The lack of online competition
makes me drop the rating by a full
star but everything else makes this
a must have for racing aficionados
and casual gamers alike.

games. All in all, the sound, the
graphics and the controls are
definitely strong aspects of the
game, especially for a 201 2
release.

almost certain that the lack of
online gamers is due to the fact
that DIRT Showdown was released
almost four years ago and there
have already been at least two
other games from the DIRT series
Besides the lack of a dedicated released ever since. It is now up to
tutorial, which for this particular
Linux gamers to breathe new life
game is not really needed, the only into the online experience for this
other negative point is the online
game by buying it and playing it
play mode. I'm sure it works great; against possibly other Linux
however, I haven't been able to
gamers.
really test it out due to there being
a lack of online gamers. I've tried
Despite the lack of online
multiple times to play online
competition, I still recommend
against other players but haven't
DIRT Showdown to fellow Linux
been able to pair up against even
gamers as it happens to be one of
one single person. In fact, at the
the best car racing games available
game's Steam Forum site, there is a for Linux at the moment. The
thread asking for friend requests
graphics, though no longer
to join in online playing. I am
revolutionary, are still pretty
full circle magazine #1 05
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Minimum Requirements:

OS: Ubuntu 1 4.1 0, Mint 1 7.1 or
similar Linux distribution
Processor: AMD Athlon 64 x2 or
Intel Core2Duo @3.2Ghz
Memory: 4 GB RAM
Graphics: nVidia/AMD OpenGL 4.1
level compatible
Graphics Memory: 1 GB
Hard Disk Space: 1 2GB
Sound: PulseAudio/ALSA
Compatible

Oscar graduated with a music degree
from CSUN, is a Music
Director/Teacher, software/hardware
beta tester, Wikipedia editor, and
active member of the Ubuntu
community. You can email him at:
7bluehand@gmail.com
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Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.
The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page that I’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.
Several people have asked for a PayPal
(single donation) option, so I’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/
fullcirclemagazine
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Full Circle Team

H OW TO CO N TRI BU TE
FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Editor - Ronnie Tucker

FCM#1 06

ronnie@fullcirclemagazine.org
Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Sunday 07th Feb. 201 6.
Release :
Friday 26th Feb. 201 6.

Editing & Proofreading

Deadline :

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker
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